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2 EB 8331-2 EN

Contents Firmware modification

Modifications of positioner firmware compared to previous version

Previous 1.1 New 1.2

In operating modes 1 and 2, travel calibration is also possible when the
valve is closed even for versions with retracting actuator stem.

1.2 1.3x

On upgrading a positioner or replacing it, an actuator calibration needs
to be performed. This is also possible without TROVIS-VIEW software.



1 General

A CD-ROM containing the program for installing the TROVIS-VIEW Configuration and Op-
erator Interface is provided by SAMSON.

Insert the installation CD-ROM to start the installation program. Once inserted, the CD-ROM
usually starts the installation program automatically, depending on the configuration of the
operating system. If the program does not start automatically, double-click setup.exe in the
root directory of the CD-ROM in order to install TROVIS-VIEW.

Follow the on-screen prompts and instructions of the installation program. The system re-
quirements are specified in the readme.txt file in the root directory of the CD-ROM.

The TROVIS-VIEW Operator Interface can be used for different SAMSON devices. Note that
the installation program also offers you the option of installing a demo module. To use the
software without restrictions, the software needs to be activated as described below:

After installation, a dialog box will appear, prompting you to enter the CD key, which you
will find on the cover of the original CD-ROM. Once you have entered the correct CD key
and initiated the activation process, a request code will be automatically generated. The Ac-
tivation dialog box will come up displaying the generated request code and an Internet link
to SAMSON’s activation server where a unique activation code will then be generated and
displayed. Enter this activation code in TROVIS-VIEW’s Activation dialog box. The software
is now ready for use without any restrictions in the purchased scope.

To enable communication with the PC, connect the serial interface to the serial interface
(RJ-12 jack) at the actuator using a SAMSON connecting cable.

A hardware package including the connect-
ing cable, memory pen, and modular
adapter can be ordered (order no.
1400-7704). The memory pen is also avail-
able separately (order no. 1400-7697).

The positioner settings configured in
TROVIS-VIEW can be directly transferred
over the SAMSON connecting cable to the
actuator on site. The transferred data are au-
tomatically checked to ensure that are com-
plete and correct.
The travel calibration for the control valve is
started by the operator interface. Positioner
settings can also be uploaded and displayed
in the operator interface.

EB 8331-2 EN 3

General

Fig. 2 · Hardware package
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2 Settings in TROVIS-VIEW

2.1 Start-up

Note!
Before you set the positioner using the TROVIS-VIEW Operator Interface, you must first
mount the actuator onto the valve as described in section 2.2 and establish the electrical con-
nections as described in section 3 of the Mounting and Operating Instructions EB 8331-1
EN.

Refer to the online help [?] for a detailed description of TROVIS-VIEW.

1. Turn the selector switch (2) to operating mode 0 =
(control switched off).

2. Check if the rated travel indicated on top of the potentiometer gear (12) corresponds
with the rated travel of the control valve.

The inscription for the rated travel ("Nennhub") is 15 (for 6 to 20 mm travel) on one side or
30 (for 6 to 35 mm travel) on the other side of the potentiometer gear.

If the rated travel indicated on top of the potentiometer gear and hence the mounting posi-
tion of the gear does not correspond with the rated travel of the control valve, pull the gear
off the shaft and put it back on again with the other side facing upward allowing the mating
gear to engage properly.

Make sure that the shaft of the potentiometer (12.1) is not adjusted.

Note!
Actuators with fail-safe action "actuator stem retracts or extends" are only designed for a
rated travel of 15 mm. Do not rearrange the gear in this case.

3. Switch on the auxiliary power.
4. Turn the selector switch (2) to operating mode 3.
5. Establish communication between the PC and actuator using the SAMSON connecting

cable.
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Fig. 3 · Selector switch and mounting position of the potentiometer gear

1 Operating mode 1
2 Selector switch
3 Operating mode 2
4 Travel calibration button
5 Operating mode 0
6 Operating mode 3
7 Potentiometer shaft (12.1)

clockwise or
counterclockwise

8 Signal lamp
9 Signal lamp
10 Actuator stem

extends or retracts
11 Jack (serial interface)
12 Potentiometer gear
12.1Potentiometer shaft

Potentiometer gear (12.2)
mounting position
for rated travel 15

Potentiometer gear (12.2)
mounting position
for rated travel 30

Rated travel
inscription

Idle gear

Idle gear

Idle gear12.2



2.2 Starting TROVIS-VIEW and performing settings

Note!
You can perform the settings in TROVIS-VIEW without the actuator being directly connected,
i.e. in offline mode and download the settings later onto the actuator.
When online mode is selected, the PC is connected over the software directly to the actu-
ator.
Online and offline modes can be switched between in the Device menu or by clicking the
icon on the device toolbar.

1. Start TROVIS-VIEW.

To upload the setting data from the actuator
onto the operator interface, select Upload from
Device in Device menu or click icon on the
device toolbar.

2. Click options in the View menu to select or
deselect them. When the Trend Viewer is acti-
vated, all operating data are uploaded cycli-
cally from the actuator in online mode and displayed in graphs.
Right-click the graph to edit the graph or to save it in a file.

3. In Options menu, select Languages to change the interface language. You can switch the
language of the interface at anytime while the software is running.
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4. Select Communications in Options menu to
open the communication window.
Click on Port settings button to determine the
port.
You can select the COM port manually or start
the automatic detection. This function searches
through all COM ports (max. 256) of the com-
puter for the device (Type 3374 Actuator) or
for the memory pen with 3374 data.
The search function is completed when the de-
vice or memory pen has been found.

5. Select User level in Device menu in order to be
able to enter or alter data.
The default setting of Maintenance technician
only allows you to read setting data. Expert
and Factory calibration requires the user to
enter a password (max. 8 characters) which
can be altered.
Default password: samson

When necessary:

6. Select Convert in File menu to choose the actu-
ator firmware version.
It must match the version specified in the dis-
play bar.

7. Select Customer data in Edit menu to enter de-
tails on the plant, if required.

8. Select Load Factory Defaults in Edit menu to
load default settings onto the operator inter-
face. Any configured data will be overwritten
by the default data.
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9. Double-click the Operating mode 3 folder in the folder hierarchy.

10.Right-click the Setting subfolder or the Setting row.
The current settings of the digital positioner are displayed.

Left-click the corresponding row to select a parameter
and double-click it to open the window to modify parameter settings.
Right-click the row to open the window to edit the parameter.

More details on the setting parameters are listed in the following table.
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Parameter Meaning

Input variable

Lower range The default values of the lower and upper ranges of the reference variable
are 4 and 20 mA.
If you, for example, want to connect two or more actuators in parallel to
achieve split-range operation, set the lower range of the actuator between
0 and 75 % and the smallest span to 25 %.

Upper range

Unit

Position feedback signal

Lower range The position feedback signal is used for remote transmission of the current
valve position and is usually the same as the input variable.
The lower and upper ranges can be set between 0 and 20 mA or
0 to 10 V.
The direction of action of the feedback signal can be reversed by setting
lower range > upper range.

Upper range

Unit

Additional settings

Priority position
(binary input)

The priority position function is activated when the switching voltage exists
at the terminals of the binary input.
If the priority position function is triggered by an external signal at termi-
nals 81 and 82 during the control operation, the actuator stem moves to
the open position (actuator stem retracts) or to the closed position of the
valve (actuator stem extends) according to the setting.
For a mixing valve, the open and closed positions are reversed accord-
ingly.
If no signal exists at the terminals, the normal control operation following
the input signal is active.

Control operation when
input variable fails

This function allows you to determine whether the last travel value or the in-
ternal reference value (described below) is used for control operation when
the input variable fails.
This control operation is activated when the input variable falls below 0.5 V
or 1 mA.

Internal reference value Default setting 50 %, adjustable between 0 and 100 %.

Binary output This function is used to determine whether the binary output signal serves
as a status monitor, as a monitor for “control switched off”
(Fig. 3: Selector switch 2 to Position 0 = )  or as a limit monitor.

EB 8331-2 EN 9

Settings in TROVIS-VIEW



Switching behavior
of limit monitor

The binary output is activated when the value falls below the adjusted mini-
mum limit or exceeds the maximum limit.
The binary output is reset when the value exceeds the minimum limit or falls
below the maximum limit plus the adjustable differential gap.
Limit monitor function:
Setting in % in relation to the travel position of the valve.

Switching value
of limit monitor

Exact final position

When this function is activated, the plug stem moves into its exact final po-
sition in the closing phase.
As soon as the travel position is reached which is closer to the closing posi-
tion than the current dead band width, the motor is controlled over a con-
stant signal. The current dead band is continuously measured by the actua-
tor and is always smaller than the maximum dead band width.
The actuator in the closing position is switched off by the limit switches.

Maximum
dead band width

Adjustable between 1.1 and 5.0 %.
A corresponding change in the input signal always leads to a travel move-
ment.

Travel

(if SAMSON memory pen is used)
In case the travel range of the control valve is transferred by the SAMSON
memory pen, you can set the travel to any value between 6.0 and
35.0 mm.

Control valve
closes when

(if SAMSON memory pen is used)
This function is used to determine whether the control valve is to close when
the actuator stem "extends" or "retracts".
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11.Double-click the Characteristic subfolder and then double-click the Characteristic row in
the list to open the Characteristic dialog box.

This dialog box displays the set
characteristic and its coordi-
nates.

The default characteristic ap-
pears as User-defined and is a
linear characteristic defined by
two coordinates.

Click Point button and select
Add to enter coordinates (max-
imum 11) for a freely
configurable characteristic.

Click Characteristic button and select Save to
save the new characteristic.

To open default and saved characteristics, select
File and Open on clicking the Characteristic
button. The files are stored in
C:\programme\samson\view3/3374/deu/.
The characteristics are saved on installing the
TROVIS-VIEW software in the directory
“view3...”.
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12.Select Download to Device in Device menu or click
on the device toolbar to download data from the operator in-
terface to the actuator.
Click OK to confirm prompted message.

Note!
You can reset the data that you have modified to the default setting at any time. To reset the
data, select Load Factory Defaults in the Edit menu.

Select Upload from Device in the Device menu or click on the device toolbar to transfer
all setting data of the control valve to the operator interface where you can check and modify
them, if necessary.

Select Download to Device in the Device menu or click on the device toolbar in order to
transfer the modified setting data back to the actuator.

Note that you can activate and deactivate the Additionally Read Factory Setting function by
clicking on the Device menu and selecting Additionally Read Factory Setting.

You can print the setting data by selecting Print in the File menu.
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2.3 Travel calibration

After downloading all the setting data to the actuator, you can calibrate the travel.

Caution!
The automatic travel calibration lasts approximately twice as long as the actuator's
transit time. During this, the valve moves out of its present position. Carry out the
travel calibration on the test bench or when the shut-off valves in the plant are closed.

1. Select Calibration of Control Valve in Device menu to open the Calibration of Control
Valve dialog box.

2. In this box, check either Calibration to Maximum travel range or to Limited travel range
and determine whether the control valve closes when the actuator stem retracts or ex-
tends.

3. In order to initialize the travel calibration, click Start Calibration button. The progress bar
indicates the calibration progress. Read the messages displayed in the status field!
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Note!
If the status field reads “Potentiometer setting is incorrect”, the corresponding signal lamp of
the positioner board starts to blink indicating that the potentiometer gear (12) has been
wrongly positioned and must be readjusted manually (see Fig. 2).
However, do not alter the potentiometer gear until the closed position is actually reached.
You can recognize when the closed position is reached by looking at the associated limit
switch located on the board which is activated by the tag (refer to EB 8331-1 EN, Fig. 5).
To proceed, use a screwdriver to gradually turn the potentiometer shaft (12.1) clockwise or
counterclockwise in accordance with the symbols (7) until the signal lamp stops blinking and
is lit constantly.
Turn the screwdriver counterclockwise if the upper signal lamp (8) blinks and turn it clock-
wise if the lower signal lamp (9) blinks. The travel calibration will not continue until both sig-
nal lamps are lit at the same time.

If the status field reads “Mounting position of potentiometer gear is incorrect” during the
travel calibration, check if the correct side of the gear is facing upwards.

If there is no travel movement during the calibration (caused by a loose or missing potenti-
ometer gear, for example), the two signal lamps blink alternately. Then, the travel calibration
is canceled after a short period of time and the error message “Controlled variable does not
change!” is displayed. Click OK, remedy the error and then restart the travel calibration.

If the status field reads “Calibration finished”, the travel has been calibrated successfully. The
actuator starts its control operation in response to its reference variable.

4. Close the Calibration of Control Valve dialog box and interrupt communication by
disconnecting the SAMSON connecting cable.
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3 Additional positioner functions

3.1 Testing

To start the test run, select Test in Device menu and then select Start. Note that you can only
perform the test run in one of the operating modes 1, 2 and 3. In order to select one of the
operating modes, turn the selector switch (2) of the positioner to the corresponding
operating mode.

The test run starts to generate an input variable which increases from the determined lower
range (if the input variable corresponds to the lower range value) to the determined upper
range at a constant rate. When it reaches the upper range value, it automatically switches
over and continuously decreases until it reaches the lower range again and stops the test
run.
This continuously changing input signal is transferred from the operator interface to the
positioner of the actuator during the test run and causes the control valve to open or close
according to the increasing or decreasing signal. The resulting travel position of the control
valve, the difference between the input variable and the travel position as well as the current
dead band width are continuously transferred from the positioner to the operator interface
during the test run and their continuously changing values can be monitored on the operator
interface.

The changing values of the input
variable (reference variable w)
and travel position (controlled
variable x) are displayed in a
graph. The input variable and the
travel position as well as their dif-
ference in percent, the current
dead band width and the operat-
ing mode are displayed numeri-
cally. You can determine the rate
of change of the input variable by
entering a time parameter in the
Time slot text box. The time pa-
rameter determines the transit
time from the lower range to the
upper range of the input variable.
This parameter should exceed the
transit time of the actuator.
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3.2 Displaying setting data

In order to display the key setting data of the positioner, double-click the Information folder
and then the Display subfolder in the folder hierarchy.

Select Upload from Device in Device menu or click on the device toolbar to upload the
current setting data and other information from the positioner and to display them on screen.
The displayed data may differ depending on the operating mode selected.
The relation between the input variable and the travel position and the characteristic are dis-
played in graphs.
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3.3 Reporting defined events

In order to display the events which have occurred during the control operation of the
positioner, double-click the Information folder and then the Messages subfolder in the folder
hierarchy.

Select Upload from Device in Device menu or click on the device toolbar to upload the
current setting data on the operator interface.

Possible defined events:

� Input variable outside of range [ < 0 %; > 105 %]

� Zero shift [has occurred]
Initialization if travel > 5 % and travel rate = 0 mm/s and input variable corresponds to
the lower range of the reference variable

� Positioner [cannot calibrate]
if error > 2 dead band widths and travel rate = 0 mm/s; time-delayed message

� Operating temperature [outside of operating range]
if temperature < 1 °C or > 64 °C

� Communication [inactive]
if time-monitored data traffic does not take place

� Control operation [with last travel value; with internal reference value]
when input variable fails
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� Operating direction of actuator stem [check]
displayed when the closed position of the control valve does not match on switching the
operating mode 3 to 1 or 2 or vice versa

� Priority operation [active]
if binary input is active

� Limit monitor [active]
if set limit value is not reached or is exceeded.

� Transmitter controlled variable

4 Factory calibration

The factory calibration comprises the basic setting of the positioner, the travel calibration of
the actuator as well as the entering of the serial number and is carried out at the factory.

If necessary, for example, if you have replaced the electronic components, you can also
carry out the factory calibration at the place of installation of the actuator. There are two dif-
ferent approaches to calibration:

� Best method to perform the calibration involves using a PC, the TROVIS-VIEW Operator
Interface, a current or a voltage source, a sufficiently precise ammeter or voltmeter and a
sufficiently precise, mechanical length measuring instrument. This method allows the ope-
ration of the actuator with the best precision.

� Simplest method to perform the calibration is possible on site without additional tools
such as a PC installed with the TROVIS-VIEW software or the measuring instruments. This
method may be used for actuator settings for HVAC applications.

Note!
The factory calibration requires that the actuator be isolated from the control valve.
The rated travel of the actuator (see nameplate) must be the same as the inscription
“Nennhub 15” or “Nennhub 30” printed on the gear that faces upwards. If this is not the
case, rearrange the gear as described in section 2.1.
After factory calibration is completed, you have to recalibrate the travel of the control valve!
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4.1 Calibration using TROVIS-VIEW software

1. Connect the PC to the interface of the positioner using the SAMSON connecting cable.
Establish the electrical connection according to the wiring diagram. Switch on voltage
supply.

2. Turn the selector switch (2) to operating mode 0 = .

3. Start TROVIS-VIEW.

4. Select User level in Device menu.
Choose Factory calibration from the
drop-down list.
Enter the required password “samson”
and click OK.

5. Select Upload from Device in Device menu or click on the device toolbar to upload the
current setting data onto the operator interface.
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4.1.1 Calibrating the input variable

6. Connect an input signal of 0 V.
Right-click the Input variable row and select Execute to start calibration. After the calibra-
tion is completed, the setting is saved and indicated by a controller symbol.
Connect an input signal of 10 V.
Right-click the Input variable row and select Execute to start calibration. After the calibra-
tion is completed, the setting is saved and indicated by a controller symbol.

7. An additional calibration of the mA input signal is not absolutely necessary. If this is not
the case, proceed as described previously for the V input signal.

4.1.2 Calibrating the position feedback signal

8. Calibrate position feedback signal to 0 mA.
Depending on the existing output signal, right-click the Increase signal or Decrease sig-
nal row and select Execute.
As soon as the correct reading is displayed at the measuring device, click Save and se-
lect Execute.
After the calibration is completed, the setting is saved and indicated by a controller sym-
bol.

Calibrate position feedback signal to 20 mA.
Right-click the Increase signal row and select Execute until the reading at the measuring
device is 20 mA.
Click Save and select Execute. After the calibration is completed, the setting is saved and
indicated by a controller symbol.

9. Calibrate the position feedback signal 0 and 10 V in the same way as for the mA signal.
.
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4.1.3 Calibrating the actuator

Actuator stem extends

10.Right-click Extend actuator stem row and select Modify in the pop-up menu.
Right-click Extend actuator stem row again and select Write in the pop-up menu.
The actuator stem extends until the limit switch switches off the actuator.

11.Measure the length of the actuator stem up to where the thread of the housing starts and
write it down.

12.Right-click Extend actuator stem row and select Modify in the pop-up menu.
Select No from the drop-down list for the value in the Modify Parameter dialog box and
click OK button to confirm.

Actuator stem retracts

13.Right-click Retract actuator stem row and select Modify in the pop-up menu.
Select Yes from the drop-down list for the value in the Modify Parameter dialog box and
click OK button to confirm.
Right-click Retract actuator stem row again and select Write in the pop-up menu.
The actuator stem extends until the limit switch switches off the actuator.
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14.Measure the length of the actuator stem up to where the thread of the housing starts and
write it down. The difference between the final positions that you have measured is the
maximum operating range of the actuator.

15.Right-click Retract actuator stem row and select Modify in the pop-up menu.
Reselect No from the drop-down list for the value in the Modify Parameter dialog box
and click OK button to confirm.

Serial number

16.Right-click Serial number row and select Modify in the pop-up menu.
Enter the serial number from the nameplate for the value in the Modify Parameter dialog
box and click OK button to confirm.

Note!
The actuator cannot be calibrated before the serial number has been entered. If you do
not have the serial number, enter a value greater than 0.

Activate the calibration

17.Right-click Activate actuator calibration row
and select Modify in the pop-up menu.
In the pop-up window, enter the values for
mains frequency, rated travel and nominal
actuating time as written on the nameplate.
Enter the maximum operating range of the
actuator in mm that you previously mea-
sured, however, the value may not be
greater than 35 mm.

18.Click Start Calibration button to perform the
calibration.
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Note!
If the factory calibration has not been carried out completely, the signal lamp (9) starts to
blink. The message that the calibration or the serial number is missing is displayed in the
“Calibration has not been carried out completely” section of the Messages subfolder in the
Information folder.

19. To exit the calibration parameter, select User Level in Device menu and change the user
level to Maintenance technician or Expert.
Enter the required password (samson) again on selecting Expert.

4.2 Simplest calibration method at the press of a button

If tools such as the TROVIS-VIEW software, PC etc. are not available for calibration of the
actuator and the actuator operation with maximum precision is not necessary, the simplest
calibration method can be performed as follows:

1. Position the selector switch (2) to operating mode 0 = .
2. Press down the travel calibration button (4) for at least 15 seconds until both signal

lamps light up.
3. Release the button to start calibration.

The actuator stem extends until the torque-dependent switches switch off the actuator.
The position of the potentiometer is checked.

4. Re-adjust the potentiometer, if necessary, while observing the signal lamps. Refer to the
description given on page 14.
After adjusting the potentiometer, the calibration of the actuator is continued.
On completion of the calibration, the maximum travel is set to 20 mm or 35 mm, de-
pending on the position of the gear.
The serial number is set to 999 999.

5. Mount the actuator on the valve.

6. Perform the calibration of the control valve.

You can perform this calibration in TROVIS-VIEW as described in section 2.3 on travel
calibration.
If you do not have this software, proceed as described in section 4.3 on Setting the digi-
tal positioner in the Mounting and Operating Instructions EB 8331-1 EN
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5 SAMSON memory pen

The SAMSON memory pen (Order No.1400-7697) is able to load and store data in its non-
volatile memory and serves as a data carrier to transfer the setting data of the positioner
from the TROVIS-VIEW Operator Interface to the actuator and vice versa.

You can select the most relevant functions
from the Memory Pen menu such as Up-
load from Memory Pen, Download to
Memory Pen, Modify Memory Pen Status
and Interface.

Note that you need a SAMSON modular adapter
(Order No.1400-7698) to transfer the setting data
from the PC to the memory pen and vice versa.
In order to transfer the setting data from the mem-
ory pen to the positioner and vice versa, you do not
require any adapter because the connector of the
memory pen fits the jack of the positioner board.
The SAMSON memory pen makes it easy to ex-
change data with the positioner. The memory pen
enables you, for example, to copy the setting data
of one positioner to the positioner of another
actuator of the same type. You can also download
the setting data from a PC or notebook to the mem-
ory pen when you are, for example, in your office
or at the place of installation of the control valve.
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Then, you can download this data to the positioner of the corresponding actuator on site.
Furthermore, you can archive the setting data of the positioner of your actuator in the mem-
ory pen. If you have to replace this actuator by a new one, you can download the archived
setting data from the memory pen to the new actuator.

Note that the calibration data needed for setting the hardware components of the positioner
can only be loaded and transferred using the operator interface and not by means of the
SAMSON memory pen. The memory pen can only be used to load and transfer the setting
data of the positioner.

If you want to use the memory pen to transfer the setting data to the positioner, for example,
first set the selector switch (2, Fig. 2) on the actuator to operating mode 0 = and then in-
sert the memory pen into the jack of the actuator. The associated signal lamp (9) starts to
blink for about 10 seconds to indicate that communication has been established successfully
and that the setting data are being checked.

If the transferred data are considered to be incorrect, corrupt or incompatible, the data
transfer is canceled and the signal lamp (9) is not lit continuously. In this case, connect the
memory pen to the PC via the adapter, open the Setting folder of the corresponding Oper-
ating mode folder and then select Upload from Memory Pen in Memory Pen menu of the
TROVIS-VIEW Operator Interface to display and check the data stored in the memory pen.

To activate the control operation with the new setting data, reset the selector switch (2) on the
positioner to operating mode 3.

The setting data can only be transferred for operating mode 3.
Transferring setting data to the positioner in operating modes 1 or 2 is not possible (excep-
tion: unit selection mA/V for input variable and position feedback signal).

Reading the setting data of the positioner is possible for both the memory pen and for the
operator interface from every operating mode. All the setting data of the operating modes
are usually read.

Note!
Select Additional settings in the Setting folder to set the travel and closed position of the con-
trol valve when using the memory pen.
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5.1 Downloading data to the positioner

Note!
Before you download data from the SAMSON memory pen to the positioner, you must first
mount the actuator onto the control valve as described in section 2.2 and establish the elec-
trical connections as described in section 3 of the Mounting and Operating Instructions
EB 8331-1 EN.

1. Turn selector switch (2) to operating mode 0 =
(control switched off, see Fig. 3 on page 5)

2. Check if the rated travel indicated on top of the potentiometer gear (12.2) corresponds
with the rated travel of the control valve.

The inscription for rated travel ("Nennhub") is 15 (for 6 to 20 mm travel) on one side or 30
(for 6 to 35 mm travel) on the other side of the potentiometer gear.

If the rated travel indicated on top of the potentiometer gear and hence the mounting
position of the gear (see Fig. 2) does not correspond with the rated travel of the control
valve, pull the gear off the shaft and put it back on again with the other side facing upward,
allowing the mating gear to engage properly.

Make sure that the shaft of the potentiometer (12) is not altered.

Note!
Actuators with fail-safe action "actuator stem retracts or extends" are only designed for rated
travel 15 mm. Do not rearrange the gear in this case.

3. Switch on auxiliary power.
4. Plug the SAMSON memory pen into the jack (11) of the positioner board and wait until

the signal lamp (9) stops blinking and remains illuminated.
5. If you want to use the travel value and the closed position of the control valve indicated in

Additional settings of the Setting subfolder, initialize the travel calibration by activating
the travel calibration button (4).
If, however, this is not the case, disconnect the memory pen from the jack, set the selector
switch (2) to operating mode 3 and perform the travel calibration according to
section 4.3 of the Mounting and Operating Instructions EB 8331-1 EN.
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Caution!
The automatic travel calibration lasts approximately twice as long as the actuator's
transit time. During this, the valve moves out of its present position. Perform the travel
calibration on the test bench or when the shut-off valves in the plant are closed.

After activating the travel calibration button (4), both signal lamps (8 and 9) remain
illuminated at the same time to indicate the beginning of the travel calibration. The actuator
stem extends as far as the closed position of the valve.
The mounting position of the potentiometer gear (12.2) is determined automatically and sig-
nalized by the illumination of the signal lamp (8) for 6 to 35 mm travel and the signal lamp
(9) for 6 to 20 mm travel.
The actuator stem retracts as far as the open position (maximum travel). When the maximum
travel position is reached, the travel calibration has been completed. The actuator starts its
control operation and the actuator stem moves to the valve position determined by the refer-
ence variable.

Caution!
If one signal lamp starts to blink slowly after the travel calibration button has been activated
and the actuator stem has extended as far as the closed position, the potentiometer (12) has
been wrongly positioned and must be readjusted manually.
However, do not alter the potentiometer until the closed position is actually reached. The
closed position is indicated by the associated limit switch located on the board and
activated by the tag. To proceed, use a screwdriver to turn the shaft of the potentiometer
gradually clockwise or counterclockwise until the signal lamp stops blinking and remains illu-
minated. Turn the screwdriver counterclockwise in accordance with the symbols (7) if the up-
per signal lamp (8) blinks and turn it clockwise if the lower signal lamp (9) blinks.
The travel calibration does not continue until both signal lamps are lit at the same time.
Note!
If both signal lamps start to blink at the same time during the travel calibration, disconnect
the memory pen from the jack and cancel the calibration by pressing the travel calibration
button.
Recheck the mounting position of the potentiometer gear (12.2) and/or the travel value indi-
cated in Additional settings of the Setting folder.
If there is no travel movement during the calibration (due to a loose or missing potentiometer
gear, for example), both signal lamps blink in alternating sequence. In this case, cancel the
travel calibration by pressing the travel calibration button (4), remedy the error and restart
the calibration by pressing the travel calibration button (4) again.
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6. Disconnect the memory pen from the jack.
7. Set the selector switch (2) to operating mode 3.

Note!
The travel calibration only needs to be performed once to start up the valve.

5.2 Uploading data to the memory pen

1. Plug the SAMSON memory pen into the jack of the positioner board and wait until the
signal lamp (9) stops blinking and is then lit continuously.

2. Disconnect the SAMSON memory pen from the jack (11).

The setting data of the positioner is stored in the memory pen and can be transferred to
other actuators or can be downloaded to the PC.

Note!:
You can only transfer the setting data from the positioner to the SAMSON memory pen if
you have selected one of the operating modes 1, 2 or 3!
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